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Devices
S1 C 88104 F 0A01

Packing specifications
 00 : Besides tape & reel 
 0A : TCP BL 2 directions
 0B : Tape & reel BACK
 0C : TCP BR 2 directions
 0D : TCP BT 2 directions
 0E : TCP BD 2 directions
 0F : Tape & reel FRONT
 0G : TCP BT 4 directions
 0H : TCP BD 4 directions
 0J : TCP SL 2 directions
 0K : TCP SR 2 directions
 0L : Tape & reel LEFT
 0M : TCP ST 2 directions
 0N : TCP SD 2 directions
 0P : TCP ST 4 directions
 0Q : TCP SD 4 directions
 0R : Tape & reel RIGHT
 99 : Specs not fixed

Specification

Package
 D: die form; F: QFP, B: BGA

Model number

Model name
 C: microcomputer, digital products

Product classification
 S1: semiconductor 

Development tools
S5U1 C 88348 D1 1

Packing specifications
 00: standard packing

Version 
 1: Version 1

Tool type
 Hx : ICE
 Ex : EVA board
 Px : Peripheral board
 Wx : Flash ROM writer for the microcomputer
 Xx : ROM writer peripheral board

 Cx : C compiler package
 Ax : Assembler package
 Dx : Utility tool by the model
 Qx : Soft simulator

Corresponding model number
 88348: for S1C88348

Tool classification
 C: microcomputer use

Product classification 
 S5U1: development tool for semiconductor products

00

00

Configuration of product number
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This manual explains the use of the in-circuit emulator (S5U1C88000H5), setting up the system and
starting up the debugger.
For the functions and operations of the debugger, see the help topics displayed in the debugger.
See also the tool manuals below which are provided for each model.
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CHAPTER 1 PREFACE

1.1 Outline
The S5U1C88000H5 package, one of the software development tool packages for the 8-bit single chip
microcomputer S1C88 Family, consists of an in-circuit emulator (S5U1C88000H5) and a debugger
(S5U1C88000H5 for Windows). It allows the programmer to efficiently debug the target system and the
target program.
This system can be used for all the S1C88 Family models. The S5U1C88000H5 in-circuit is compatible
with each model of the S1C88 Family by installing the Peripheral Circuit Board (S5U1C88xxxP) that is
provided for each model.
The S5U1C88000H5 system provides an advanced software developing environment that uses a personal
computer as the host computer.

ICE88UR E0C88 Family In-Circuit Emulator

Fig. 1.1.1  S5U1C88000H5 external view

1.2 Operating Environment
To construct an S5U1C88000H5 system, the following equipment is necessary in addition to this package:

Personal computer
   - IBM-PC/AT or compatible model with Windows 2000 or Windows XP installed.
   - 80486DX2 66 MHz CPU or higher and 24MB RAM are recommended.
   - A USB port is required in the personal computer.
   - A hard disk drive, a 3.5" floppy disk drive (1.44MB) and a mouse are required.

Display unit
   - A 16 or more color display.
   - 1024 × 768 dot display is recommended.

Peripheral Circuit Board, other development tools
   - Prepare the Peripheral Circuit Board and development tools (software) for the model to be developed.

Basic software
   - The S5U1C88000H5 system is compatible with Windows 2000 or Windows XP. Note that it is not

guaranteed to work with other versions.

∗ The name 'ICE88UR' on the development
tool is the old name of the product.
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CHAPTER 2 S5U1C88000H5 PACKAGE

2.1 Components
After unpacking the S5U1C88000H5 package, check to see that all the following components are included.
Figure 2.1.1 shows the package drawing.

• S5U1C88000H5 main unit

• AC adapter • USB interface cable

• AC cable

• Floppy disk
  (3.5" 2HD, 1.44MB)

• User registration card
• Warranty card

Registration
..............
..........
............
........

• S5U1C88000H5 Manual

One each 
for English and Japanese

One each 
for English and Japanese

One

One

One

One

One each 
for English and Japanese

DISK 

POW
ER

EM
U

SLP
/H

ALT

RESET

TRGOUT

STOPOUT

TRCIN

BRKIN
GND

ICE88UR E0C88 Family In-Circuit Emulator

ON/OFF

DIAG

EPSON

CMOS 8-bit Microcomputer S1C88 Family

S5U1C88000H5 Manual

SEIKO EPSON CORPORATION

Fig. 2.1.1  S5U1C88000H5 package

2.2 Component Specifications
Table 2.2.1 shows the component specifications in the S5U1C88000H5 package.

Table 2.2.1  S5U1C88000H5 component specifications

Components

S5U1C88000H5

main unit

USB I/F cable

AC adapter

AC cable

Accessories

Package

Remarks

Rubber feet included

Peripheral Circuit board is sold separately

Rubber feet excluded

Outside: 5 V, Inside: 0 V

One each for English

and Japanese

Items

Dimensions

Weight

External color

Input voltage

Current consumption

Board mounted

Length

Dimensions

Input voltage

Input frequency

Power consumption

Output voltage/current

Length

Plug type

System disk

Manual

Warranty card

User registration card

Dimensions

Materials

Total weight of package

Specifications

270 (W) × 192 (D) × 79 (H) mm

Approx. 2.5 kg (main body)

Cygnus white

DC 5 V

2 A, max.

ICE board (one)

2 m

160 × 80 × 60 mm

AC 90 V to 264 V

47 Hz to 63 Hz

25 W, max. (in ICE system load)

DC 5 V/5 A, with overcurrent protection

1.8 m

Bipolar with ground

3.5" 2HD, 1.44MB (two)

S5U1C88000H5 Manual

380 (W) × 260 (D) × 225 (H)

W carton, cardboard

Approx. 4 kg
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CHAPTER 3 IN-CIRCUIT EMULATOR (S5U1C88000H5)
3.1 Outline
The S5U1C88000H5 emulates the functions of the S1C88 core CPU and is used by installing a Peripheral
Circuit Board for each model. The S5U1C88000H5 is connected to a personal computer via the USB port.
The following shows the features of the S5U1C88000H5:
- Supports all the S1C88 Core CPU models
- 576KB of emulation memory built-in
- Advanced emulation functions (continuous execution, step execution, trace, break, coverage, etc...)
- On-the-fly function for real time monitoring memory.

See help topics of the debugger for details of the debugging functions.

Emulation Memory
The S5U1C88000H5 built-in emulation memory consists of the following two parts:

(1) 64KB emulation memory

This part corresponds to a 64KB area from address 000000H to address 00FFFFH in the accessible
memory space of the S1C88 core CPU.

(2) 512KB emulation memory

This part can be allocated to a 512KB area within address 010000H to address FFFFFFH. To allocate
the emulation memory to a 512KB area to be used, specify the address in a parameter file that is read
at the S5U1C88000H5 system start-up.

Thus the emulation memory can be used as an external memory that is generally prepared on the target
board if the capacity of the external memory is 512KB or less. It is especially useful for debugging sys-
tems that have ROMs as the external memories.

Further, external RAM on the target board can also be debugged like the emulation memory.
See the development tool manual of the model to be developed or the "S1C88 Family Development Tool
Manual" for specifying memory configuration.

3.2 Operating Environmental Conditions
Table 3.2.1 shows the environmental conditions that have to be used to operate the S5U1C88000H5.

Table 3.2.1  Environmental conditions

Remarks

No condensation

Items

Operating temperature

Storage temperature

Operating humidity

Storage humidity

Resistance to vibration

Specifications

5 to 40 °C

-10 to 60 °C

35 to 80%

20 to 90%

Operating: 0.25 m/S2

Transportation: 1 m/S2
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3.3 Specifications of Operation Panel
Figure 3.3.1 shows the external view of the panels and Table 3.3.1 shows the function of each part of the panels.

Fig. 3.3.1  External view of S5U1C88000H5 panels

Table 3.3.1  Function list of operation parts

No.
1

2

3

4

5

6

7
8
9

10
11

12

13

14

Position
Side

Front

Front

Front

Front

Front

Front
Front
Front

Front
Front

Front

Back

Back

Function
The breaker cuts off the power of the S5U1C880000H5 system (ICE 
board, Peripheral Circuit board and target board) at consumption 
current of 4 A or more. A small staff of the breaker comes up at the 
shut-off. The staff should be at the recessed position for normal 
operating status. The breaker does not work at the normal operation.
Upon coincidence of trigger conditions with a tracing trigger point, a 
pulse is output from this terminal.
When the S1C88 CPU is in HALT or SLEEP status, low level signal 
is output from this terminal. This is used to measure execution rate 
of the CPU. At the break mode, low level signal is also output.
Information is stored in the trace memory by connection with a 
signal of the target system.
A running program enters in break status by input a low level signal 
from the target system.
In case the above terminal is monitored with such an oscilloscope, 
the GND line of the oscilloscope is connected to this terminal. This 
is also used as a GND in case the signals are input to the above 
terminals.
This green LED lights upon power-on of S5U1C880000H5.
This red LED lights when the target program is in running status.
This yellow LED lights when the S1C88 CPU stops executing the 
program.
This switch reset S5U1C880000H5. (for maintenance)
Setting up when the S5U1C880000H5 power on, execute the self 
diagnostic test or not
This is a connector to connect the USB interface cable.

This is a connector to connect the DC cable of the AC adapter 
dedicated for S5U1C880000H5.
Turns the S5U1C880000H5 power on and off.

Indicated symbol
CB

TRGOUT

STOPOUT

TRCIN

BRKIN

GND

POWER
EMU
SLP/HLT

RESET
DIAG

DC 5V

POWER SW

Name
Circuit breaker

Tracing trigger output
terminal
HALT/SLEEP status
output terminal

Trace input terminal

Break input terminal

Ground terminal
for above

Power-on LED
Emulation LED
Halt LED

Reset switch
Diagnostic switch

Connector for connecting
USB interface cable
DC input connector

Power switch

Note: In case of change the mode by the diagnostic switch, be sure to shift it at power off the S5U1C88000H5.

POW
ER

CB

POW
ER S

W

DC 5
V IN

EM
U

SLP
/H

ALT

RESET

TRGOUT

STOPOUT

TRCIN

BRKIN
GND

ICE88UR E0C88 Family In-Circuit Emulator

ON

OFF

7 8 2

14

1

13

3
4

5
6 10 12119

ON/OFF

DIAG

Front

Front ←

Back

Side
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CHAPTER 4 SETTING UP EQUIPMENT

Connect the equipment as shown in Figure 4.1.

Note: Be sure to turn all the system equipment off before installation and connection.

AC cable

 USB I/F cable

Peripheral Circuit Board

Personal
computer

To DC 5V IN

AC adapter
POW

ER
EM

U

SLP
/H

ALT

RESET

TRGOUT

STOPOUT

TRCIN

BRKIN
GND

USB portS5U1C88000H5

ON/OFF

DIAG

Fig. 4.1  Connection of S5U1C88000H5 system

(1) Installing the Peripheral Circuit Board

Install the Peripheral Circuit Board for the model to be developed to the S5U1C88000H5. The target
board is connected to the Peripheral Circuit Board. Refer to the Peripheral Circuit Board manual of
each model for how to install the Peripheral Circuit and target boards.

(2) Connecting the USB interface cable

Connect the S5U1C88000H5 to the personal computer using the USB interface cable supplied in this
package.

(3) Connecting the AC adapter

Be sure to use the AC adapter supplied in this package for supplying power to the S5U1C88000H5.
Connect the DC cord plug of the AC adapter to the DC 5V IN connector of the S5U1C88000H5. For the
AC adapter, connect the AC cable supplied in this package. Use the same ground line between the
S5U1C88000H5 and the host computer.

Note: Make sure that the equipment is installed and/or connected properly before turning the power on.
The USB interface cable can be hot plugged.
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CHAPTER 5 INSTALLING SOFTWARE
This package contains two 3.5" floppy disks (English and Japanese). Make backup copies before installing
the software.

!! Read the Readme.txt file recorded in the disk !!
The Readme.txt file contains precautions. Be sure to read it before installing the software.

To install the tools
The debugger software should be installed in the host computer’s hard disk using the dedicated
installer. Follow the installing procedure described below. The explanation uses mouse operation, i.e.
click, but key operation is also available. When using the keyboard, enter the underlined letter on the
buttons.

(1) Start Windows. If the OS is already active, close
active programs.

(2) Insert the supplied disk into the drive.

(3) Double-click Setup.exe.

Welcome
(4) Click on the [Next>] button to proceed.

Choose Destination Location
A dialog box for specifying the folder in which to install
the tools appears.

(5) If you do not wish to change the default settings,
simply click the [Next>] button to execute installa-
tion.

To install in another folder
Click [Browse...] to bring up the [Choose Folder]
dialog box. From this dialog box, enter the path or
select the folder in which to install the tools. Click the
[OK] button to finish folder selection and then click
the [Next>] button.
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Select Program Folder
(6) Enter the desired program folder name and click the

[Next>] button. To use the default folder name, simply
click the [Next>] button.

The installer will start installing the tools.

Setup Complete
(7) Click [Finish] to terminate the installer.

Program menu
The folder of tools is registered to the program menu by the installer.

To end installation
All dialog boxes that appear during installation have a [Cancel] button. To prematurely terminate
installation, click [Cancel] in the dialog box when it is displayed.

To uninstall
To uninstall the installed tools, use "Add/Remove Programs" on the Control Panel.
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CHAPTER 6 OPERATION

6.1 Starting up S5U1C88000H5 for Windows
The following shows the start-up procedure of the S5U1C88000H5 system.

(1) Turn the S5U1C88000H5 in-circuit emulator on.

Note: • After connecting the S5U1C88000H5 system, make sure that the equipment is installed and
connected correctly before turning the power on.

• After the S5U1C88000H5 is turned off, do not turn the S5U1C88000H5 on for at least 10
seconds. It may cause a malfunction in the S5U1C88000H5.

The S5U1C88000H5 debugger checks the S5U1C88000H5 hardware and files required. The check result is
displayed in the [Command] window. If any error message appears and the debugger does not start up
normally, terminate the debugger (choose [Exit] command from the [File] menu), then check the follow-
ing points.

   - Is the Peripheral Circuit Board installed in the S5U1C88000H5 properly?
   - Is the S5U1C88000H5 connected to the personal computer with the USB interface cable properly?
   - Is the S5U1C88000H5 turned on?
   - Is the appropriate parameter file prepared? (see Section 6.3)

(2) To start up the debugger, select Ice88ur.exe from the
program menu.

The debugger window below is appeared.
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6.2 End Procedure
To terminate S5U1C88000H5 for Windows, choose the [Exit] command from the [File] menu.
Do not turn the S5U1C88000H5 off until the debugger is terminated.

6.3 Initial Setup File (ICE88UR.INI) and Parameter File (.PAR)
The Ice88ur.ini file installed in the Windows system folder (\windows) contains the following initial
setup information for the S5U1C88000H5 debugger.

Model=
A model name to be developed is specified. The model name described here will appear on the
S5U1C88000H5 status bar.
Example: Model=E0C88316

Path=
A parameter file is specified.
The parameter file (.PAR) contains the memory mapping information for the model to be developed and
information for allocating an external memory area to the S5U1C88000H5 emulation memory. It is read
into the debugger (S5U1C88000H5 for Windows) at start-up. The development tool package for each
model includes a parameter file that contains a basic memory configuration. It is necessary to customize
the contents if the system to be developed has an external memory. Refer to the development tool manual
of each model or the "S1C88 Family Development Tool Manual" for the contents of the parameter file and
how to customize it.

The installer in this package installs the parameter file "Default.par" for starting up the debugger in the
same folder as the debugger program and sets it as the default parameter file so that the debugger will
read the file at start-up. To set the debugger to read an actual parameter file used for development, it is
necessary to rewrite this Path= specification so that the necessary parameter file will be read in.
Example: Path=DEFAULT.PAR → Path=C:\E0C88\DEV88316\88316.PAR

When specifying a parameter file existing in the same folder as the debugger program (Ice88ur.exe),
rewrite the file name only. When specifying a parameter file existing in another folder, the path should be
described.

CCFile=
A command chain file is specified. When a command chain file name is entered here, the S5U1C88000H5
debugger will automatically execute the commands described in the specified file after it starts up. Use
the command chain file for the S5U1C88000H5 environment configuration and loading program and
option files after starting up.
Example: CCFile=C:\E0C88\DEV88316\test.com

When specifying a command chain file existing in the same folder as the debugger program (Ice88ur.exe),
rewrite the file name only. When specifying a command chain file existing in another folder, the path
should be described.

6.4 Debugging
To read a target program and to debug the program, choose the command from the menu, click the tool
bar button, or enter the debug command directly in the [Command] window.
See Help in the debugger for debugging functions, operations and details of the debug commands.
To open the help window, choose the [Index...] command from the [Help] menu. The contents of the help
topics appear. Clicking an underlined item jumps to the topic.
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CHAPTER 7 PRECAUTIONS

(1) Connecting and disconnecting the equipment
Be sure to turn the personal computer and the S5U1C88000H5 off when installing the Peripheral
Circuit Board or connecting cables and disconnecting them. Otherwise, the internal circuits of the
equipment may be destroyed.

(2) Turning the power on and off
Do not turn the S5U1C88000H5 on for at least 10 seconds after it is turned off. Turning the power on
without the interval may result in abnormal operation of the S5U1C88000H5 or in the circuit breaker
cutting off. It may also cause a malfunction.

(3) Overcurrent protection
When the S5U1C88000H5 is turned on under the condition that VDD and VSS are short-circuited on the
target system, the AC adapter cuts off the output current due to the overcurrent protection function.
In this case, the Power LED on the S5U1C88000H5 does not light up.
3 A or a more steady-state current on the target system cuts off the circuit breaker of the
S5U1C88000H5.

(4) Difference between the emulation memory and the RAM in the actual IC
Both the S5U1C88000H5 emulation memory and the RAM in the actual IC are undefined at power-on.
The set values are not same, therefore be sure to initialize the memory with the program.

(5) Difference between memory operations by the debugging commands and memory
access by programs
Memory dump and other memory operations by the debugging commands use the firmware clock
(default: 4 MHz) in the S5U1C88000H5. Memory access by the target program uses an emulation clock
similar to the actual IC. Therefore, the read data may differ between the program and the debug
command when low-speed devices or devices that delay outputting data are used on the target board.
In such cases, use a low-frequency firmware clock set by the debugging command (CLK command).

(6) Setting up USB port
USB functions may be disabled in some personal computers by default. Make sure that the USB port
is enabled and setup the BIOS configuration of the personal computer if necessary.

Do not connect the plural S5U1C88000H5 to the USB port. One personal computer can be connected
only one S5U1C88000H5.
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Menu Shortcut key Button Function Command

[File] [Open...] Ctrl + O Loading program LF

[Save...] Ctrl + S Saving program SF

[Options...] Ctrl + Shift + O --- Loading options LO

[Symbol] --- --- Loading/saving symbols LS, SS

[Condition] --- --- Loading/saving conditions LC, SC

[Log...] Ctrl + L --- Logging LOG

[Exit] Alt + F4 --- Terminating debugger Q

[Edit] [Copy] Ctrl + C, Ctrl + INS --- Copy to clip board ---

[Paste] Ctrl + V, Shift + INS --- Paste from clip board ---

[Modify] [Assemble...] Ctrl + A --- Assembly A

[Edit...] Ctrl + E --- Editing memory contents E

[Fill...] Ctrl + F --- Filling memory area F

[Move...] --- --- Copy memory M

[Move to em...] --- --- Copy target memory to emulation memory MVE

[Register...] Ctrl + R Modifying registers R

[Search] [Data...] Shift + F3 --- Data search DS

[Symbol...] F3 --- Symbol search SYS

[Trace...] Ctrl + F3 --- Trace memory search TS

[View] [Source-Source level] Ctrl + 1 C source display SET

[Source-ASM Mix] Ctrl + 2 C source & disassembly display SET

[Source-ASM] Ctrl + 3 Disassembly display SET

[Dump...] Ctrl + D --- Memory dump D

[Trace...] Ctrl + T Trace data dump TD

[Coverage] --- --- Coverage display CV

[List...] Alt + F3 Specifying program display location LI

[Map] --- --- Memory mapping information display MA

[Run] [Go] F5 Program execution G

[Go from Reset] Shift + F5 Program execution after resetting G

[Go with Options...] Ctrl + F5 --- Program execution from specified location G

[Step Into] F8 Step into SI

[Step Over] F10 Step over SO

[Step Exit] Shift + F7 Step exit SE

[Animate-Step Into...] Alt + F8 --- Step into with step count SI

[Animate-Step Over...] Alt + F10 --- Step over with step count SI

APPENDIX LIST OF MENUS, SHORTCUT KEYS

AND DEBUG COMMANDS
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Menu Shortcut key Button Function Command

[Break] [Full Area...] Shift + F9 --- Setting break points for full area BA, BAR

[1MB Area...] F9 Setting break points with area specification BP, BPR

[Sequence...] Ctrl + Shift + F9 --- Setting sequential break mode BAS

[Data...] Ctrl + F9 --- Setting data break condition BD, BDR

[List] Alt + F9 List of break conditions BL

[Data] [Symbol...] Shift + F2 Registering/deleting symbols SY, SYR

[Parallel Dump...] Ctrl + F2 Setting parallel dump points PD, PDR

[Watch...] F2 Setting watch points W, WR

[Tools] [Tool bar] --- --- Tool bar on/off ---

[Status bar] --- --- Status bar on/off ---

[Others] [Macro] --- --- Macro MC, MCR

[Stub] --- --- Stub STB, STBR

[Scope] --- --- Function name display SCP

[Calculation...] --- --- Calculation CAL

[Command Chain...] Ctrl + G Command chain COM

[Variables...] Ctrl + Shift + F2 --- Variable display VAR

[History...] Ctrl + H --- Command history ---

[Window] [Cascade] --- --- Arrangement of windows ---

[Tile Horizon] --- --- Arrangement of windows ---

[Tile Vertical] --- --- Arrangement of windows ---

[Arrange Icons] --- --- Arrangement of icons ---

[1 Source] Alt + 1 --- Opening [Source] window OW

[2 Dump] Alt + 2 --- Opening [Dump] window OW

[3 Register] Alt + 3 --- Opening [Register] window OW

[4 Parallel dump] Alt + 4 --- Opening [Parallel dump] window OW

[5 Local] Alt + 5 --- Opening [Local] window OW

[6 Watch] Alt + 6 --- Opening [Watch] window OW

[7 Break] Alt + 7 --- Opening [Break] window OW

[8 Trace] Alt + 8 --- Opening [Trace] window OW

[9 Coverage] Alt + 9 --- Opening [Coverage] window OW

[10 Map] Alt + 0 --- Opening [Map] window OW

[11 Search result] Alt + Shift + 1 --- Opening [Search result] window OW

[12 Stdout] Alt + Shift + 2 --- Opening [STDOUT] window OW

[Environment] [Clock Select...] Shift + F4 --- Clock selection CLK

[CPU Reset] Ctrl + I CPU reset RST

[Set...] F4 --- Environment settings SET

[Trace Mode] --- --- Setting trace mode TM

[Trace Trigger] --- --- Setting trace trigger point TP, TPR

[Help] [Index...] --- --- Contents of help ---

[Using Help...] --- --- How to use help ---

[About...] --- --- Version display

--- --- Esc Stop execution ---
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